
uplinkearth Hosting Services Guide 
A guide to hosting services at uplinkearth, version 2. 
 
 
 

What is the ule Hosting Services Guide? 
The purpose of the ule Hosting Services Guide is to provide an overview of hosting 
services at uplinkearth. 
 

How to use the Hosting Services Guide 
 
In your PDF viewer open the Bookmarks option in your left pane, press F5 on your 
keyboard. 
 

[yourdomain] 
Whenever you see "[yourdomain]" we are referring to your domain name.  
 
So for example, if your domain name is "joesmithphoto.com" and you see a 
reference to  http://www.[yourdomain], what you should assume is meant is 
http://www.joesmithphoto.com. 
 

http://www.joesmithphoto.com/


Contacting us 
For support issues, we ask you do not email support@uplinkearth.com. If you have a 
support issue, create a support ticket in your control panel, or contact us by phone. 
 

Phone Support 
 
Office/Phone support hours can be found on our contact page at: 
 
http://www.uplinkearth.com/contact.cfm  
 
Phone support is not available for all virtual hosting plans. Please refer to our virtual 
hosting plans before calling. 
 
As with any correspondence, abusive or offensive language will not be tolerated. 
Please keep in mind support technicians are ready to help you solve your problem. 
 
All our support staff are well trained in-house technicians. We do not out source our 
technical support so you get knowledgeable friendly capable support. 
 

Ticket System Support 
 
If you need assistance with your hosting services, please login to the control panel 
and create a support ticket (see Login to your control panel). The ticket system is 
monitored by knowledgeable and friendly support technicians ready to answer your 
questions (see Opening a Support Ticket). 
 

mailto:support@uplinkearth.com
http://www.uplinkearth.com/contact.cfm


Opening a Support Ticket 
 
Help us help you 
 
When creating a support ticket include as much information as you can in clear 
sentences in English. The more detailed your description of the issue is, the faster 
tech support will be able to resolve your question or problem. As with any 
correspondence, abusive or offensive language will not be tolerated. Any support 
ticket that contains abusive or offensive language will not be processed. 
 
Make sure you include 
 

 A specific question, request, or description of the issue to the best of your 
ability.  

 
 The name of specific file, page, or script you are having trouble with, and it's 

location (if applicable).  
 

 A list of the exact steps you are taking to produce the error or result.  
 

 The operating system and any client or browser software you are using and, if 
appropriate, which version.  

 
 The error message or output if any (cut and paste it into the ticket if you 

can). 
 
 
Response time for your issue will vary depending on the volume of issues in the 
queue and the type of issue. Some requests require specialized technicians or may 
take longer to resolve. Typically you will receive a response within 6 hours, but the 
longest it should ever take to get a response is 24hrs. 
 
To create a support ticket follow these easy steps 
 
Log into your control panel (see Login to your control panel). 
 

 On the start page of your control panel click the "new ticket" button. 
 Then select the plan type (if you have multiple plan types or registered 

domains) or domain you would like the open a ticket for. 
 Fill in the subject field by briefly describing the request or question you have. 
 In the description field type your request or question in detailed sentences in 

English. 
 Once complete, click the green submit button. 

 



Basic Programming Support 
We provide basic programming support for the configuration and availability of our 
hosting services, and only via the online ticket system. Technical support does not 
provide support for website programming, unless it is a programming issue related 
to the configuration of your hosting services. A support technician will provide the 
necessary information to help solve your issue, but a support technician cannot 
analyze or modify your code. 
 
 
Help us help you 
 
When creating a support ticket include as much information as you can in clear 
sentences in English. The more detailed your description of the issue is, the faster 
tech support will be able to resolve your question or problem. 
 
If you need basic programming support, first open a support ticket with the following 
detailed information: 
 

 Description of the problem to the best of your ability.  
 

 Error message (cut and paste it into the ticket if you can). 
 

 Script Name and location (i.e. "mydomain.com/feedback.asp" would be 
sufficient).  

 
 Any extra information needed to access the script, if any (i.e. if the script in 

behind a login area provide a user name and password we can use to test it). 
 
Debugging your web site code, providing instructions on how to write scripts or web 
page code, or developing or modifying your web pages is beyond the facility of Tech 
Support. For Advanced Programming services such as these please contact the sales 
office at sales@uplinkearth.com to obtain the current hourly rate for a web 
programmer. 
 



Email Support 
Support issues are never handled through email for accounting and security reasons. 
 
For this reason support@uplinkearth.com is not monitored. Please do not send 
questions or requests to support@uplinkearth.com; you will not get a response. If 
you need to correspond with technical support for questions or requests concerning 
your hosting services please create a support ticket through your control panel (see 
Opening a Support Ticket). 
 
 
Only sales and accounting questions are handled through email correspondence. 
 
Sales: sales@uplinkearth.com 
Accounting: accounting@uplinkearth.com
 

Accounting and billing support 
All accounting and billing inquiries are handled by email or phone. Office hours are 
listed in the Phone Support section. Accounting’s email address is 
accounts@uplinkearth.com. 
 

mailto:accounting@uplinkearth.com
mailto:accounts@uplinkearth.com


Become an active participant 
We consider your concerns and needs in every decision we make about you and your 
services. We invite you to provide feedback, suggestions and ideas at any time. 
Email them to webmaster@uplinkearth.com. 
  
You can also exchange ideas, techniques, and code with other uplinkearth customer 
by visiting the user forum at: 
  
https://forum.uplinkearth.com    
  
Your login credentials for the forum are the same as for your user control panel. 



Virtual Hosting Services 
uplinkearth virtual hosting services aim to provide a safe, secure environment for 
domain hosted websites. uplinkearth provides you with access to virtual server 
resources to publish your website on the Internet.  
 
We assume that by purchasing virtual hosting service, you are able to create and 
maintain your website by your own means. 
 
At this time we do not offer instruction for HTML coding, programming, publishing, or 
instruction on using any of the applications needed to create and maintain your 
website. 



Your uplinkearth username 
Your username is the key to all your services at uplinkearth. Your username is a 
system assigned name generated from a combination of letters from your first name 
and your last name.  Names that are long will get truncated. Names that are 
common might end up including some numbers to ensure uniqueness. 
 
This assigned name is your permanent username with uplinkearth and it cannot be 
changed. This is the same username you will use for logging into the control panel, 
FTP, and your administrator webmail account. 

Your uplinkearth password 
Your password is chosen by you when you open your account with uplinkearth. If 
you would like to change your password, please open a support ticket indicating 
what you would like to change it to (see Opening a Support Ticket). 
 
You use this password to access all of your services, including control panel, FTP, 
and webmail. 



uplinkearth User Types 
There are three different user types possible within your hosting account. 
 

1. Hosting Administrator – is the owner of the account; typically it is the 
person who originally opened the account. The Hosting Administrator has full 
rights to all aspects of the account including control panel, account and billing 
information, FTP, email, and MSSQL if applicable. 
 

2. DB (database) Administrator – has administrator (db owner) rights to a 
specified database (only applicable for MSSQL SQL plans). 
 

3. FTP User – only has FTP access to the folder specified by the Hosting or 
Domain Administrator 

 



Login to your control panel 
To login to the control panel, open up a browser and go to 
http://www.uplinkearth.com/.  
 
Click the login button on the upper right of the page underneath the uplinkearth 
logo . 
 

 
The login button on the uplinkearth.com home page opens the login page. 

 
Clicking the login button will open the login page. On the login page, type in your 
uplinkearth username and uplinkearth password and click the login button (see 
Your uplinkearth username and Your uplinkearth password for more information 
about usernames and passwords respectively). 
 
If you have forgotten your password use the Forgot your password link. In the 
Forgot Password pop-up window, type in the email address listed in your account 
information (This is the email address you signed up with if you haven’t changed it in 
your control panel).  Your password will be sent to that address and only that 
address. 
 

http://www.uplinkearth.com/


Your virtual server 
Your virtual server has been designed to make hosting your website easy and 
secure. The webserver your virtual server uses to handle HTTP requests is Microsoft’s 
Internet Information Services 6 (IIS6) running on Microsoft Windows 2003 Server 
operating system.  
 

Your 'Webspace' 
Any areas of your virtual server reachable by browser (via HTTP) can be considered 
a webspace. This initially includes the www folder. Any sub-domains (or hosts) (see 
Sub-domains) are also considered to be in the webspace.  
 
An HTTP request is what happens when you type in a web address into your 
browser’s address bar and press enter. Being “reachable by browser (via HTTP)” 
refers to where the webserver will look for http requests.  
 



Your folders (directory structure) 
Your root directory is your starting point for managing all your website’s files. All 
domains you are hosting under that account will be contained in your root directory. 
 
 

 

root directory - is where you are when you log 
into FTP. All domains you are hosting under the 
account you have logged into will be contained in 
your root directory. 
  
[yourdomain]_com - is where all the folders and 
files for a domain is contained. We name the 
folder with your domain name and replace the '.' 
with a '_'.  
  
data - write permissions are enabled in this folder. 
The data folder is generally used to accommodate 
HTTP upload functionality (see HTTP upload). 
  
databases - is where you put the MS Access 
databases you want to have write permissions for.  
 
We do not allow write permissions in the webspace 
for security reasons (See Write Permissions). This 
is for your protection as well as ours.  
  
forums – this is an example of a sub-domain. 
Sub-domain folders are located at the same level 
as your www folder (see Sub-domains). 
  
www - is where your website's files are kept. It is 
also known as the webspace, which means it is 
visible from the web. 
  
  

 



Custom Error Pages 
By default your virtual server is configured with default error pages to display when 
an error occurs. For example, if someone requests a page that no longer exists on 
your website, a 404 Page not found error is displayed, which is basic HTML page. 
You can create your own custom error pages to replace them. 
 
You can configure a custom error page in your control panel. On the Hosted Plans 
Page. First create the HTML page: 
 
Create your custom error and name it using the error number. For example, if you 
are creating a 404 error page, name the file 404.htm. Create an _errors directory 
in the www folder and place your custom error pages in there.  
 

Custom ASP Error Pages 
When an ASP error occurs, you can capture the error and display your own error 
message using specific visual basic objects available at the time of the error. If you 
have created an ASP error page, create an _errors folder in the www folder and 
place the custom ASP error script in there.  
 
If you would like more information on how to create an ASP error page, see the 
following Microsoft article: 
  
http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q224070&ID=KB;EN-
US;Q224070&&FR=1
 

http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q224070&ID=KB;EN-US;Q224070&&FR=1
http://support.microsoft.com/default.aspx?scid=KB;EN-US;Q224070&ID=KB;EN-US;Q224070&&FR=1


Default Documents 
The default document is the webpage the webserver will look for when one is not 
specified. 
 
For example, if someone types your domain into their browser address bar without 
specifying a document (http://www.[yourdomain.com]), the webserver will look 
in your www directory to see if one of the following pages exists: 
 
default.asp 
index.asp 
default.aspx 
index.aspx 
index.htm 
index.html 
default.htm 
default.html 
index.cfm 
index.php 
index.pl 
 
If the webserver finds a page in the default document list, it will display it. If it does 
not find one of the default documents, the webserver will respond with a Directory 
Listing Denied error. When there is no default document the webserver will attempt 
to list the contents of the directory (by default uplinkearth virtual servers configured 
not to allow directory listings). 



Domain Mirrors 
A domain mirror is a domain that “mirrors” another domain.  
 
uplinkearth defines a domain mirror as a domain that mirrors an existing domain 
exactly (i.e. a mirrored domain points to the same physical content as the existing 
domain and uses the same web host configuration). Domain mirrors are configured 
with their own DNS entries. Domain mirrors do not have mail services. 
 
For example, you can have mydomain.com and mydomain.org point to the same 
website folder. 
 
Domain mirrors cost $1 per month per mirror. 
 
Domain mirrors can be configured in your control panel on the Hosted Plans Tab. 



Forums and Portals 
Some forum and portal website software that require write permissions in the 
webspace (see Your 'Webspace') for it’s normal operation are not supported. 
 
Some installations can be modified to make use of writable folders outside the 
webspace; however, it is your responsibility to make the necessary modifications. 
 Tech support can provide information to help you configure the application, but 
cannot analyze or modify your code (see Basic Programming Support). 
 
We can create a writable folder in the webspace at your request, however, script 
execute permissions will be turned off for any folder that is writable. We do this 
because having write and execute in the same folder is a security hole due to how 
Windows Servers handle user permissions. 
 
If you would like a writable folder created please put in a ticket requesting what 
folder you would like configured that way and a support technician will create it for 
you. (see Opening a Support Ticket) 
 



HTTP Upload 
HTTP upload operations can be accommodated with writable folders outside the 
webspace (see Your 'Webspace'). Have your scripts upload user data into a writable 
folder outside your webspace (see our FAQ located on the support page at 
http://www.uplinkearth.com/support.cfm for available ASP upload components).  
 
To reach the uploaded data via HTTP, we can create a virtual directory with a name 
of your choice that resolves to the writable folder outside your webspace; this virtual 
directory will have read-only permissions. 
 
To have a vitrual directory configured, open a support ticket indicating the virtual 
directory's name, and the physical folder you would like the virtual directory to 
resolve to (see Opening a Support Ticket). 
 
We can create a writable folder in the webspace at your request, however, script 
execute permissions will be turned off for any folder that is writable. We do this 
because having write and execute in the same folder is a security hole due to how 
Windows Servers handle user permissions. 
 
If you would like a writable folder created please put in a ticket requesting what 
folder you would like configured that way and a support technician will create it for 
you. (see Opening a Support Ticket) 
 

http://www.uplinkearth.com/support.cfm


Publish with FrontPage 
We understand that publishing with FrontPage can sometimes be problematic. If you 
run into a problem, make sure you write down the exact error message you get. 
Open a support ticket (see Opening a Support ticket) indicating the steps you took, 
and the error message you wrote down. uplinkearth support technicians are on the 
lookout for FrontPage issues. Generally if you follow the steps below, you shouldn’t 
have a problem: 
 
 

1. Turn on FrontPage in your control panel (see Control Panel, Logging In, and 
Site Manager). 
 

2. Open FrontPage. From the File menu from the main toolbar select Publish 
Web. 
 

3. You will get a Publish Web pop-up window. In the Specify the location to 
publish your web to dropdown field type in http://www.[yourdomain.com] 
and click Publish. If your domain name change has not completed yet, use 
the temporary URL given to you in your confirm email. It should look like 
http://[yourdomaincom].[servername].uplinkearth.com/. 
 

4. You will get the Name and Password Required pop-up. For the Name field 
use your uplinkearth [firstname.lastname] username. In the Password field 
use your uplinkearth password and then click OK. 

 
 
Once you click OK you will see your files being transferred to your virtual server. If 
during the process you are prompted for FTP information it means there is a problem 
with your FrontPage installation. Open a support ticket (see Opening a Support 
ticket) indicating FrontPage is asking you to FTP instead of Publish. A support 
technician will check and reconfigure your FrontPage installation if necessary. 
 



Sub-domains 
(The correct term is actually host or host entry, though it is commonly referred to as 
a sub-domain.) 
 
Sub-domains can be added through the control panel. Login to the control panel and 
click the Site Manager icon for the domain you would like to add a sub-domain to. 
Submit a sub-domain request through the Sub-domain(s) to [yourdomain] link. 
 
The files for that sub-domain are located in a folder at the same level as your www 
folder named the exactly like the sub-domain. This is also considered a part of your 
webspace. For example, if you had a sub-domain called forums.[yourdomain], the 
folder would be called forums (see Your folders (directory structure)). 
 
Subdomains can be added in your control panel through the Hosted Plans tab. 
 



The File Manager (uleExplorer) 
ulExporer is a quick and effective tool for maintaining to your web site. We 
designed it to work like the Windows Explorer and included the ability to Copy, 
Move, Delete, and Rename, entire folders or individual files. We also included an 
upload and edit facility. 
 
uleExplorer starts you in your root directory by default.  
 
Text based files are clickable and can be edited through a browser based notepad 
like application.  
 
To manipulate files and folders, click their icons to turn the check mark on and off. A 
check mark on indicates you have selected to work with that file or folder. Once you 
have selected a file or folder to work with click the desired action to perform: Copy, 
Move Delete or Rename.  
 



uplinkearth Components Offering 
Overview 
Our virtual server component offering has been selected by determining which 
components have the greatest usefulness to the greatest number of people. 
 
When a component is approved for use it gets deployed across all our servers to 
keep our component offering consistent for each virtual machine for technical and 
support considerations. For this reason deploying a component is a commitment 
itself in administrative and technical resources, so more than just the component's 
cost is weighed when considering new additions. 
 
If you need a component not currently offered by uplinkearth you may request to 
have it installed.  If you decide to make a request please open support ticket 
indicating this specifically and it will be forwarded to Network Admin for 
consideration (see Opening a Support Ticket). 



Website Software Installations 
Some forum and portal website installations require write permissions in the 
webspace (see Your 'Webspace') for the installation only. If you need to perform this 
type of installation please open a support ticket (see Opening a Support Ticket) and 
a support technician will assist you. 
 

Write Permissions 
We can configure a writable folder in the web space (anyplace reachable via http) at 
your request, however, script execute permissions will be turned off for 
any folder that is writable. Having write and script execute permissions in the 
same folder is an exploitable security hole for Windows Servers. 
 
If you would like a folder configured for writing, please create a support ticket 
requesting the folder you would like to have write permissions enabled on. A support 
technician will configure the permissions for you. 
 



FTP settings and Information 
If you are familiar with FTP programs use the following settings to set up your 
uplinkearth FTP account. See the following sections. 
 
 
Host name:  [yourdomain.com] (Or temporary URL indicated in your set-up 
confirmation email) 
  
Host directory: /[yourdomain_com]/www 
  
Host type:  automatic 
  
User ID:  your uplinkearth [firstname.lastname] username 
  
Password:  your uplinkearth password 
 
 
 



FTP with Dreamweaver 
FTPing is the supported method of publishing for Dreamweaver: 
 
1. From the main toolbar at the top, select Site -> Define Sites. 
 
2. From the Define Sites selection window select your website or create a new 
one if you do not have your website configured as a Dreamweaver site. 
 
3. From the Site Definition window select Remote Info. 
 
4. From the Access drop down select FTP. 
 
5. For FTP Host use [yourdomain.com] without the http:// or if you are using 
your temporary URL, type that in the same way (i.e. 
[yourdomaincom].[servername].uplinkearth.com). 
 
6. For Login use your uplinkearth username. 
 
7. For Password use your uplinkearth password. 
 
8. Click the OK button to save your changes. 
 
9. The Define Sites selection window should still be open at this point. Click the 
Done button and the Site manager window will load up. 
 
10. Next to the Sites: [yourdomain] dropdown on the main toolbar, click the 
Connect to remote host button. 
  
11. Once connected you will see the root directory of your virtual server in the left 
panel of the Site manager window. 
 
12. Double click into the [yourdomain_com] folder.  
 
13. Inside the [yourdomain_com] locate and double click the www folder. This is 
where your website's files go (see Your folders (directory structure)). 
 
14. Drag and drop the files you wish to FTP to your virtual server. 



FTP with Internet Explorer 
This is probably the easiest method of FTPing if you do not have an FTP program 
already. Internet Explorer has FTP functionality built into it that only requires you to 
specify FTP instead of HTTP when typing in your domain name: 
 
1. Type ftp://www.[yourdomain.com] in your browser's address bar or if you are 
using your temporary URL, type 
ftp://[yourdomaincom].[servername].uplinkearth.com (Note there is no dot between 
[yourdomain] and [com]). 
 
2. In the User Name field of Internet Explorer's Login As pop-up type in your 
uplinkearth username. 
 
3. In the Password field of Internet Explorer's Login As pop-up type in your 
uplinkearth password and click OK. 
 
4. Once you have logged in, you will be at your root directory. Locate the 
[yourdomain_com] folder and double click into it. 
 
5. Inside the [yourdomain_com] locate and double click the www folder. This is 
where your website's files go (see Publishing your website). 



FTP with WS_FTP LE 
WS_FTP LE is a free Windows FTP client that is reliable, easy, and recommended if 
you have no other FTP program available.  
 
If you would like to download a copy of WS_FTP LE go to the 
http://download.com.com/ website and type in WS_FTP LE in the search box towards 
the top of the page. You will be presented with a download link for the program.  
 
Follow the instructions for download and installation. 
 
1. Open up WS_FTP LE (If you have just downloaded it, make sure you install it 
first). 
 
2. When the program loads the Session Properties window will pop-up. 
 
3. Click the New button to add a new profile for your virtual server. 
 
4. For Profile Name use [yourdomain]. This is really just a description for the 
profile so technically you can type anything you think is appropriate. 
 
5. For Host Name/Address use [yourdomain] without the http:// or ftp://, or if 
you are using your temporary URL, type that in the same way (i.e. 
[yourdomaincom].[servername].uplinkearth.com; note there is no dot between 
[youdomain] and [com]).  This is the domain name it will try to connect to. 
 
6. For Host Type leave Automatic detect selected. This is a default setting. 
 
7. For User ID use your uplinkearth username. 
 
8. For Password use your uplinkearth password. 
 
9. Once finished, click Apply and then OK to connect to your virtual server. 
 
 
 
The left panel contains a view of the folders and files on your computer. The right 
panel contains a view of the folders and files on your virtual server. To transfer files 
to your virtual server: 
 
1. In the right panel, click into the [yourdomain_com] folder and then click into 
the www folder. This is where the webserver will look for your website's files (see 
Your 'Webspace'). 
 
2. Locate them in the left panel and highlight each file by clicking on each one 
while holding down the CTRL button on your keyboard. 
 
3. Once you have all the files you need to copy to your virtual server selected, 
click the Right Arrow button located in the middle of the screen. 
  



 Name server information 
 Registering a new domain name with uplinkearth 
 Domain Mirrors 
 Parking a domain 
 



Email Services Overview 
Email services at uplinkearth are provided by the use of the virtual mail server 
(VMS). This is your allocated mail server. Your VMS handles all POP3 and SMTP for 
your domain. So for example, if your domain name is my-domain.com your VMS is 
addressed as mail.my-domain.com. 
 
 
The quantum plan and up have an unlimited number of users (see Unlimited Email 
User Policy).  
 

Unlimited Email User Policy 
The unlimited email accounts feature of the quantum plan virtual mail servers is 
intended to give businesses or websites room to grow with worrying about email 
address limitations. 
 
It is not to be used to host your own free email service such as Hotmail. If we find 
you abusing the service in this way, your mail server will be limited to the number of 
email accounts you have at that time or 50 email accounts. 



Administrator Email Account 
By default, we create a single user for the administrator account using your 
uplinkearth username (see Your uplinkearth username). 
 
This is a system assigned account that cannot be deleted or changed.  
 
If you would like to specify an additional account as an administrator account, please 
open a support ticket indicating which existing email account you would like to 
change to an administrator (see Opening a Support Ticket). 
 
Webmail and your username
 
When logging into webmail, your webmail administrator username can include 
@[yourdomain], for example "joe.smith@mydomain.com". Use the entire email 
address if your domain name's nameserver information has not updated yet and you 
are using the name of your mail server to get to log into webmail. 
 
If your domain is resolving and you can reach your webmail via 
http://mail.[yourdomain], you can leave off the [@yourdomain] part of your 
email address and just type your username. 



Setting up Microsoft Outlook/Outlook 
Express/ Outlook XP 
 
1. Open up 
Outlook/Expres
s/XP and go to 
the main menu 
options Tools -
> Accounts .  
 
Selecting 
Accounts will 
open up the 
Internet 
Accounts 
Window. 
  

 
On the main toolbar select Tools -> Accounts 

  
  
  
  
  
  
  
  



2. In the 
Internet 
Accounts 
window Click on 
Add -> Mail . 

 
Click on Add and select Mail. 

  
  
  
  
  
  
  
  



3. In the 
Display Name 
field type what 
you would like 
to appear as 
your name 
when using that 
email address 
and click Next 

. 

 
Type your name in the Display Name field. 

  
  
  
  
  
  
  
  



4.  For the E-
mail address 
field type in 
your full email 
address: 
  
[username]@[
yourdomain] 
  
and click Next 

. 

 
Type your entire email address in the E-mail address field. 

  
  
  
  
  
  
  
  



5. For My 
incoming mail 
server select 
POP3 . 
  
For Incoming 
Mail(POP3 or 
IMAP)server 
type in your 
VMS’s address, 
mail.[yourdo
main] . 
  
For Outgoing 
Mail(SMTP) 
server type in 
your VMS’s 
address, 
mail.[yourdo
main] and click 
Next. . 

 
Select POP3 and use your VMS's address mail.[yourdomain.com]  for both POP

SMTP. 
  
  
  
  
  
  
  
  



6. For Account 
name use your 
entire email 
address: 
  
 [username]@
[yourdomain] 
  
For the 
Password field 
type in your 
uplinkearth 
password or 
whatever 
password you 
chose for that 
email account 
and click Next 

. 
  

 
Use your entire email address and email password. 

  
  
  
  
  
  
  
  



7. Choose your 
connection type 
depending on 
your connection 
method.  
  
If using DSL or 
a cable modem, 
choose the 
Connect 
through LAN 
option . 
  
Click Next. 

 
Select your connection type. 

  
  
  
  
  
  
  
  



8. Click Finish 
.  

  
Once this is 
complete, your 
account has 
been created. 
There is only 
one more step: 
Turning on 
SMTP 
Authentication. 

 
You are done! 

 



SMTP Authentication 
 
Your uplinkearth mail server requires SMTP secure authentication option in your 
email client to be enabled. If this option is not enabled in your email client, mail you 
send from your email client will not get delivered; you will also not receive any error 
or bounce message that your mail was not delivered. 
  
We have included instructions for some of the more popular email clients below, 
including Outlook, Outlook Express, and ThunderBird.  
  
If you are using an email client not listed here, please read through the below 
instructions to familiarize yourself with the procedure, and then refer to your email 
client's documentation. 
 
Outlook Express:  
 

1. Click the "Tools" menu 
and select the 
"Account" option. An 
Accounts window will 
appear. 

2. Select the account you 
are working with, and 
click the "Properties" 
button in the right of 
the window. A 
Properties window for 
that account will 
appear.  

3. Click the "Servers" tab 
of that window.  

4. Towards the bottom of 
that tab, check the "My 
outgoing server (SMTP) 
requires 
authentication" option.  

5. Then click the 
"Settings" button next 
to that option. An 
Outgoing Mail Server 
window will appear. 

6. Select the "Use same settings as my incoming mail." 
7. Try resending 

 
Outlook 2002,2003,XP: 
 



1. Click the "Tools" Menu and select the "Email Accounts" option. An accounts 
window will appear. 

2. Select the "View or change existing email accounts" option. Then select an 
account to modify. You can double click the account name. 

3. Click the "More settings" button. In that window, select the "Outgoing server" 
tab. 

4. Check the "My outgoing server (SMTP) requires authentication" option. 
5. Also check the "Use same settings and my incoming mail" option. 
6. Try resending. 

Thunderbird (or Mozilla Suite): 
 
For Thunderbird, you will need to use the "Use name and password" option for your 
SMTP server. Note: SMTP authentication has nothing to do with a secure (SSL) 
connection. Neither does the "Use secure authentication" option, which is for POP3 
(incoming mail) rather SMTP 
(outgoing mail). 

   

1. Go to "Tools -> Account 
Settings -> Outgoing Server 
(SMTP)". (If using Mozilla 
Suite: go to "Edit -> Mail & 
Newsgroup Account Settings 
-> Outgoing Server 
(SMTP)".) Check the "Use 
name and password" option. 

2. Add your username. Your 
username is your full e-mail 
address (e.g., 
"johndoe@domain.com") and 
Click "OK". 

3. Thunderbird will ask you for 
your password the first time 
you send email and you can 
optionally save it at that 
time. 

4. Try resending. 

 



About the web mail interface 
The webmail interface is a modified version of Humankind System’s Killer Webmail. 
Since it is heavily driven by JavaScript and DHTML, we recommend using at least 
Internet Explorer 5.5. If you are using Netscape, use at least Netscape 6 (though 
some features do not produce the most desired effects). Any previous versions of 
Netscape are not supported. 
  
The basic features of webmail are outlined here for your convenience. There is more 
detailed information about the aspects of webmail and mail administration available 
in the webmail's Help Topics system (see Webmail help). 
 

Using the webmail interface 
The webmail interface is a modified version of Humankind System’s Killer Webmail. 
Since it is heavily driven by JavaScript and DHTML, we recommend using at least 
Internet Explorer 5.5 and above, or FireFox. 
 

Webmail help 
In the Administration and Preferences drop down select the Help Topics option (it's 
about half way down). The Help Topics option will open the Online Help pop-up 
window  . 
  
  
  
 Online Help pop-up window. 
  
  
All aspects of the webmail interface and mail administration are available in the Help 
Topics system. 
 
By default, we create a single user for the administrator account using your 
uplinkearth username (see Your uplinkearth username). 
 



Login to webmail 
Login to your webmail interface by going to the mail host for your domain. For 
example, if your domain is mydomain.com, your webmail interface can be accessed 
by typing the following into your browser:  
  
http://mail.mydomain.com 
  
   

 
 Webmail login screen. 

  
  
  
If your domain name's nameserver record change has not completed yet, you can 
log into webmail using your virtual mail server's (VMS's) temporary URL which looks 
like: 
  
 http://[server name].uplinkearth.com 
  
Use your administrator username for Email Address  . For webmail, your 
administrator username can include @[yourdomain], for example: 
  
joe.smith@mydomain.com 
  
Use the entire email address if your domain name's nameserver information has not 
updated yet and you are using the name of your mail server to access webmail. If 
your domain is resolving and you can reach your webmail via 
http://mail.[yourdomain], you can leave off the @[yourdomain] part of your 
email address and just type your username. 
  
Your password is your uplinkearth password   
 



Modify your email settings 
All aspects of your user account can be modified using the Administration and 
Preferences drop down located in the upper right hand corner of the webmail 
interface . 
  

 
Administration and Preferences drop down located in the upper right hand corner. 

  
  
See the follow sections for common administrative tasks: 

• Setting your reply-to address 
• Create users (email accounts) 
• Create an alias 
• Create a forward 
• Create a catch-all address 
• Create lists 
• Customize webmail 

 
 



Setting your reply-to address 
Log into webmail (See Login to webmail). In the Administration and Preferences drop 
down select the User Info option (see Modify your email settings).  
 
In the My User Info pop-up window, modify the Reply To Email field  with the reply-
to address you would like to use and click Save. 
 
 
 Modify the Reply To Email field. 
 

Create a catch-all address 
The Catch-all-address will capture all invalidly addressed email sent to your domain. 
To create a Catch-all-address, create an alias account called "nobody" (see Create 
an Alias).  



Create a forward 
Log into webmail (See Login to webmail). 
  
In the Administration and Preferences drop down select the Forwarding option (see 
Modify your email settings) . You will get the User Preferences  pop-up window . 
  

 
The User Preferences pop-up window. 

  
  
Type in the email address you would like to forward all mail to into the My 
Forwarding Address field. It can be any email address. Once you create a forward, 
all email addressed to this account will be forwarded immediately to the specified 
email address without saving a copy in the inbox.  
  
You will no longer see email being received for this forwarded account, nor will sent 
email from this account be stored in the sent folder.  



Create an alias 
An alias is an email address that forwards all email received by it to the email 
addresses specified in it's settings. An alias can forward email to a single email 
address, multiple email addresses, or a list. 
  
To create an alias, first, log into webmail (See Login to webmail). 
  
In the Administration and Preferences drop down select the Alias Administration 
option (it’s about half way down, see Modify your email settings). In the Alias 
Administration pop-up window click the Add button .  
  
  

 
Alias Administration pop-up window. 

  
  
  
The Alias ID field will be the email address for the alias . The Group File is the 
name of any list you would like to include. Place the email address(es) you would like 
messages received by this account to be sent to in the Destination field. Separate 
multiple email addresses with a line break (pressing Enter on your keyboard after 
each email address). 
  
  



 
Fill in the Alias ID and Destination fields in the Alias administration pop-up 

window. 
   
  
Alias names are limited to 45 characters and must be created from the character set 
of A-Z, a-z, 0-9, '_' and '-'. If an alias is created with the same name as a user in 
this domain, the alias will override the user account. 
  
  



Create lists 
To create list, first, log into webmail (See Login to webmail). 
  
In the Administration and Preferences drop down select the List Administration 
option (it’s about half way down, see Modify your email settings). The List 
Administration pop-up window will open . 
  

 
List Administration pop-up window. 

  
  
In the List Administration pop-up window, fill in Name field with the name of the 
list you would like to create.  This is the email address of the list you want your users 
to post to. For example, if you enter the name "support," users will send mail to the 
list by specifying the To address: support@[yourdomain].  
  
The name must be from 3 to 23 characters in length, with no spaces between 
characters. 
  
For more detail about list functionality and settings, see the webmail help topic (see 
Webmail help). 
  



Create users (email accounts) 
Log into webmail (See Login to webmail). In the Administration and Preferences drop 
down select the User Administration option (it’s about half way down, see Modify 
your email settings).  
  
  
Click the Add button and you will get the following screen . 
  

 
The Add User pop-up window. 

  
  
  
Fill the UserID field in with the name of the email account you would like to create. 
For example, if you would like to create sales@[yourdomain], just type in sales.  
  
User IDs may be from 3 to 30 characters long and may consist only of alphanumeric, 
'_', '-', and periods. Passwords may be from 4 to 30 characters long and cannot 
contain spaces.  
 
Click Save to add the account and close this window. 
 



Hosting your domain name with 
uplinkearth 
Having your domain hosted at uplinkearth means the domain records with your 
domain registrar has our name server information specified. We do not at any time 
take ownership of your domain. Your domain belongs to you. We serve only as the 
name server host and the canse of a domain you register with uplinkearth, the 
technical contact. 
 
 



Changing your nameserver information 
("transferring" your domain) 
Three things to consider when setting up a web host for your domain are:  
  

1. Your domain registrar.  
2. Your name server information with your domain registrar. 
3. The 72 hour name server change waiting period. 

  
  
Your domain registrar 
  
This is the place where your domain is registered. For example, if you register a 
domain with Network Solutions, your domain registrar is Network Solutions until you 
transfer your domain to another registrar. 
  
When changing your web host you do not have to transfer your domain registration. 
You need only to specify new name server information with your current domain 
registrar (specifying new name servers for a domain is often incorrectly referred to 
as “transferring a domain” which lends itself to some confusion). 
  
  
Your domain name server information
  
When someone types your domain name into their browser, it gets the information 
about where your domain is hosted from your domain registrar; it uses the name 
server information to get the computer address of the server your website is hosted 
on (the process is actually a little more in depth, but in the interest of keeping it 
simple and brief, this is essentially what happens). 
  
In order for your domain to resolve to your website hosted at uplinkearth, the name 
server information specified in the domain records at your registrar should be: 
  
  
Primary: ns1.uplinkearth.com  (IP address: 65.211.123.67) 
Secondary: ns2.uplinkearth.com  (IP Address: 65.211.123.36) 
  
  
The process of changing your name server information varies from registrar to 
registrar. For instance, some registrars have a control panel where you can do it 
your self. Contact your domain registrar to find out how.  
  
If you are not sure who your domain registrar is, go to 
http://www.internic.com/whois.html and type in your domain name. Your domain 
registrar will be listed in the query results. 
  

http://www.internic.com/whois.html


The 72 hour name server change waiting period
  
It could take up to 72hrs for your domain name to resolve to your new hosting 
account. This has nothing to do with uplinkearth’s services. All the servers on the 
Internet that handle routing website requests need time to recognize your name 
server change, which usually takes no more than 72 hours. 
 



Name server information 
 
See Changing your nameserver information ("transferring a domain") for more 
information about the nameserver change process. 
 
Primary: ns1.uplinkearth.com  (IP address: 65.211.123.67) 
Secondary: ns2.uplinkearth.com  (IP Address: 65.211.123.36) 
 

Parking a domain 
To register a domain, go to http://www.uplinkearth.com and click the register 
domain link. You may also find a register domain form at the bottom of any page at 
uplinkearth.com (see Registering a new domain name with uplinkearth). 
 
  
If you register a domain with uplinkearth you may park it at uplinkearth for as log as 
it is valid for free. Your domain will resolve to a parked page, which will indicate it is 
parked at uplinkearth. 
 

Registering a new domain name with 
uplinkearth 
When registering a domain name with uplinkearth, you retain full legal ownership of 
the registration. We only serve as the technical contact.  
 
If you need to update domain records at any time you can login to the control panel 
and submit a request to update domain your domain records. Use the "registered 
domains" tab of the control panel. Select the domain you would like to manage from 
your list of registered domains at uplinkearth and you will be provided with 
management options for that domain. 
 
 
You may park any domain registered at uplinkearth for as long as the domain is valid 
for free. 
 
  
To register a domain, go to http://www.uplinkearth.com and click the register 
domain link. You may also find a register domain form at the bottom of any page at 
uplinkearth.com. 
 

http://www.uplinkearth.com/
http://www.uplinkearth.com/
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